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UPDATES (April 14 2022): 
●​ Added power thesaurus to approved extensions (APPROVAL FROM AB ED) 
●​ List of printers as bookmark 
●​ Updated list of GAM commands to transfer ownership of documents (backup) to repository 

account, remove share permissions, delete Drive contents & trash and then execute a 
password reset  

●​ Google has released a new admin feature for pushing keyboard (languages) based on OU 
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STEP 1: Create  Exam OU and User Settings 
 

●​ Create an OU for exam users. 
●​ Device Management->Chrome Management->User Settings 

○​ Select the OU where your Exam Users are held from the left panel. 
○​ Wallpaper > Upload Wallpaper > Use Secure Exam jpg 
○​ Avatar > Upload Avatar > Use Secure Exam Avatar jpg 
○​ Allowed Types of Apps > uncheck all but Extension 
○​ Force-installed Apps and Extensions > Google Docs,, and Hide Google 

Docs Research, Power Thesaurus Google dictionary extension stopped 
working 
Accent Grid, Dictionary, Thesaurus & Reference 

○​ Allow or Block All Apps and Extensions - Block all apps and extensions 
except the ones I allow 

○​ Allowed Apps and Extensions > Google Docs, Hide Google Docs 
Research, Google Dictionary, Power Thesaurus 

○​ Password Manager > Never allow use of password manager 
○​ Screen Lock > Never automatically lock screen on idle  
○​ Incognito Mode > Disallow incognito mode 
○​ Home Button > Always show Home button 
○​ Homepage > Homepage is always the Homepage URL, set below 

■​ https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhe
lUGjG0kFoyFrMfWPeHE9xEmPw8/copy 

○​ Pages to Load on Startup 
■​ https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhe

lUGjG0kFoyFrMfWPeHE9xEmPw8/copy  
○​ Screenshot > Disable Screenshot 
○​ Cast> Do not allow users to cast 
○​ Pop-ups > Allow all pop-ups 

https://chrome.google.com/webstore/detail/google-docs/aohghmighlieiainnegkcijnfilokake?hl=en
https://chrome.google.com/webstore/detail/hide-google-docs-research/fnifdkggkcjiaahokngjoajgpboaaojb?hl=en
https://chrome.google.com/webstore/detail/hide-google-docs-research/fnifdkggkcjiaahokngjoajgpboaaojb?hl=en
https://chrome.google.com/webstore/detail/power-thesaurus/hhnjkanigjoiglnlopahbbjdbfhkndjk?hl=en
https://chrome.google.com/webstore/detail/accent-grid/efedjomeallaomheefphgnbleieplnfk
https://chrome.google.com/webstore/detail/dictionary-thesaurus-refe/cljhbajmjhfhjfnebjhgdhmggdookcio


○​ Blocked URLst: 
■​ * 
■​ https://docs.google.com/picker/ 
■​ https://docs.google.com/a/rdpsd.ab.ca/picker 
■​ https://docs.google.com/spreadsheets/d 
■​ https://docs.google.com/presentation/d 
■​ https://docs.google.com/drawings/d 
■​ https://docs.google.com/a/rdpsd.ab.ca/presentation/ 
■​ https://docs.google.com/a/rdpsd.ab.ca/drawings/ 
■​ https://docs.google.com/a/rdpsd.ab.ca/spreadsheets/ 
■​ https://docs.google.com/a/rdpsd.ab.ca/forms/d/ 
■​ https://docs.google.com/forms/d/ 
■​ https://accounts.google.com/logout 
■​ https://accounts.google.com/AddSession 
■​ https://accounts.google.com/AccountChooser 
■​ https://accounts.google.com/SignOutOptions 
■​ https://workspace.google.com/ 
■​ https://translate.google.com/ 
■​  

○​ Must blacklist these specifically even though * is blocked. 
○​ Blocked URL Exceptions 

■​ chrome-untrusted://print/ 
■​ Chrome://settings/languages 
■​ chrome://print 
■​ https://drive.google.com/ 
■​ https://drive.google.com/drive/ 
■​ https://drive.google.com/drive/my-drive 
■​ https://docs.google.com/a/rdpsd.ab.ca 
■​ https://docs.google.com/document/u/0/ 
■​ https://goo.gl/zWFc0Z 
■​ goo.gl/zWFc0Z 
■​ https://docs.google.com/document/d 
■​ https://drive.google.com/drive/shared-with-me 
■​ https://content.googleapis.com/ 
■​ https://apis.google.com 
■​ Chrome://settings-frame/languages 
■​ https://google.com/static 
■​ https://googleusercontent.com 
■​ https://www.thefreedictionary.com/ 
■​ https://www.freethesaurus.com/ 
■​ https://accounts.google.com 
■​ https://docs.google.com/accounts 

 

https://www.freethesaurus.com/
https://www.freethesaurus.com/
http://accounts.google.com


 
○​ Managed Bookmarks 

■​ https://drive.google.com/drive/my-drive    [Name: Exam 
Recovery] 

○​ Bookmark Bar > Enable Bookmark Bar 
○​ Bookmark Editing > disable bookmark editing 
○​ Google Translate > Never offer translation 
○​ Developer Tools > Never allow use of built-in developer tools 
○​ Form Auto-fill > Never auto-fill forms 
○​ DNS Pre-fetching > Never pre-fetch DNS 
○​ Multiple Sign-In Access > Block multiple sign-in access for users 
○​ Search Suggest > Never allow users to use Search Suggest 
○​ External Storage Devices > Disallow external storage devices 
○​ Audio Output > Disable audio output 

 

STEP 2: Create Exam Template 
 
We created an exam template 
that has the ID#, current 
page and total pages in the 
footer, and is double-spaced 
formatted.  If you create your 
own template, you simply 
need to replace the “edit” at 
the end of the document 
address with “copy” to force a 
copy on a new user.  Here is 
our example (feel free to 
modify and use): 
https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfW
PeHE9xEmPw8/copy 
 
**This link needs to be added in the user 
settings as the homepage and pages to load 
on startup.  The added bookmark (exam 
recovery) allows the student access to the 
Drive if the device fails, loses power, etc.  We 
have also added a second bookmark for the 
printing document which is listed in the 
printing section of this document. 
 
 

https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/copy
https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/copy


STEP 3: Create Exam Users and Apply to Exam OU 
We created a new OU for all exam user accounts (Google Exams) and then separated 
them by school.  We created the exam accounts and using naming protocols that 
identified the school and that it is an exam account (i.e., 
ltchsexam001(at)rdpsd.ab.ca for Lindsay Thurber, hhhsexam001(at)rdpsd.ab.ca for 
Hunting Hills, etc) and then associated them with the appropriate OU’s.  Next we 
created Google spreadsheets for each school with the appropriate usernames and 
passwords.  Teachers will be responsible for cutting these up and giving each kid 
the username and password at the beginning of the exam (similar to Quest A+). 
 

STEP 4: Set Up Native Printing 
 
We now use native printing by chromebook OU IPP queues 

STEP 5: Set up GAM to backup exams, delete all files and trash & 
reset passwords nightly 
Please contact glen.scharf(at)rdpsd.ab.ca if you are experiencing issues or need help with 
your GAM commands. 
 
UPDATE: 
 
New GAM commands.  Please note we are using GAM Advanced X (GAMADV-X).  We 
ran this last night against our 2500 exam accounts and it finished in 33min.  
Advantages of this version of GAM include: output file with any errors or failures, 
speed, not having to recreate accounts daily and the respository account is not 
getting “spammed” with transfer emails. 
 
gam redirect stdout Transfer.out multiprocess redirect stderr stdout csv "RDPSD Exam 
Accounts MASTER - RDPSDgam.csv" gam user ~Email transfer drive 
google.exam.repository@rdpsd.ab.ca targetuserfoldername "#user#" 
 
gam redirect stdout ChangePW.out multiprocess redirect stderr stdout csv "RDPSD Exam 
Accounts MASTER - RDPSDgam.csv" gam update user ~Email password ~PW 
 
gam redirect stdout EmptyTrash.out multiprocess redirect stderr stdout csv "RDPSD Exam 
Accounts MASTER - RDPSDgam.csv" gam user ~Email empty drivetrash 
 
Special thanks to Ross Scroggs for GAMADV-X and his assistance in setting this up 

https://github.com/taers232c/GAMADV-XTD3


for us. 
 
Please note that this is the solution RDPSD is using but may not be right for your 
environment.  If you have a different solution, please share it below. 
 

Foothills School Division 
We do the same process @ Foothills - we run GAM wrapped in PowerShell to pull the 
exam documents out and convert them to Word and then run a purge on the exam 
folders.  
 

Wild Rose School Division 
WRSD does a similar process. We use GAM in a scheduled task to back up all GDocs 
from our exam accounts (in MS format) to a share in Azure. All GDocs are then 
purged (including trash). This process happens automatically, daily. All exam 
accounts are able to be re-used without IT intervention. Here are the commands to 
do this: 
 
 
 
 
GAM command to copy all GDocs: 
 
gam.exe ou_and_children exam.wrsd.ca show filelist id | gam csv - gam user 
~Owner get drivefile id ~id format microsoft targetfolder 
F:\exam-backup\%DATE:~10,4%\%DATE:~4,2%\%DATE:~7,2%\~~Owner~~ 
 
The above command will create a directory structure on the drive F: that will look 
like: exam-backup/<year>/<month>/<day>/GAFEUserName. Our schools assign 
specific exam accounts to specific students, so we’re able to determine which 
student was on which account per exam per day, in case something needs to be 
found. 
 
GAM command to purge: 
 
gam.exe ou_and_children exam.wrsd.ca show filelist id | gam csv - gam user 
~Owner delete drivefile ~id purge 
 
This will purge the Google Drive files for ALL users under the specified OU. Replace 
“exam.wrsd.ca” with whatever is appropriate for you. This command will 
recursively parse user accounts. 
 
GAM command to delete everything from trash for all users in OU strucuture: 



 
gam.exe print users Email query orgUnitPath="/exam.wrsd.ca" | gam csv - gam user 
~primaryEmail empty drivetrash 
 
Again, replace “exam.wrsd.ca” with whatever’s appropriate for your environment. 
 
Our thought process: 
 
First off, our schools use these exam accounts on a regular basis - not just for 
provincial assessments.  So we needed to find a solution that could be used by our 
teachers daily, and would not require constant updates, PW resets, changes, etc.  
That’s where GAM comes in. 
 
To be compliant with Ab Ed’s new directive to backup all provincial assessments for 
AT LEAST 30 days, we needed to find an efficient solution that did not require the 
students to do anything.   
 
 

Known Vulnerabilities/Security 
Concerns 
Research Tool 
 
Myles Doupe of Chinook’s Edge School Division has 
created and published a Chrome Extension that “hides” 
the research pane - in both Google Docs and Google 
Slides.  Essentially the extension covers the 
research pane area so this also means the define menu will also be covered (and 
inaccessible).  We are recommending installing the Google dictionary extension to address this 
issue. 

 
The Hide Google Docs Research extension has 
been published publicly but we are still very much 
in the testing stage.  I would encourage anyone 
who uses it to give feedback in this document. 
 
I have tested the extension and installed it via the 
admin console in the following two ways.  The first 
is by searching through the Chrome Web Store 
option (top left) but I have also had very good 
success using the Specific Custom App link 
(bottom left).  If you choose the Specific App option 

https://github.com/jay0lee/GAM/wiki
https://chrome.google.com/webstore/detail/hide-google-docs-research/fnifdkggkcjiaahokngjoajgpboaaojb?hl=en


(which I’m currently recommending) use the following credentials: 
 
ID: fnifdkggkcjiaahokngjoajgpboaaojb 
URL: https://chrome.google.com/webstore/detail/hide-research/fnifdkggkcjiaahokngjoajgpboaaojb 
 
 
Publish to Web 
We have not found a way to remove this option.  However, I do not see this as a serious 
concern because even if the students were publishing their exam to the web, they would 
have to find a way to distribute the link and theoretically no one should have internet 
access, or a device on their persons that would allow for that sharing.  And running the 
GAM command would automatically delete the documents so there would not be a 
document to access after the fact.  
 
Sharing to the Exam Accounts 
Currently there is no way to limit users from receiving internally shared files.  This means a 
student could share a Google Doc with the exam account(s) and it would appear in Shared 
with Me.   
 
Two thoughts of this issue: 

1.​ Any shared file would be associated with the student account meaning you would 
instantly be able to track the file and know who shared it.  Sharing from external 
domains has been deactivated. 

2.​ Exam proctors/supervisors would need to check the shared folder before, during 
and after the exam.  As the exam logins/user accounts would be not be known to the 
students until the moment of the exam, the only conceivable way to cheat would be 
to share the doc with all of the exam accounts.  Proctors/administrators could easily 
login to multiple exam accounts at random to see if anything had been shared.      

 
Read and Write for Google 
 
New Feature Switcher: https://support.texthelp.com/help/feature-switching  
Works great, you just have to upload the .json file for every OU. Here’s a link to one that only 
allows the play, pause and stop button. 
https://docs.google.com/document/d/11iKnYjMGmqnErLrm-CJkV_UA_sKz8GtLy0jpWyluKW0/e
dit?usp=sharing  
Read and Write is a fantastic assistive technology that allows students to convert text to 
audio and vice versa.  It DOES NOT however, gives admins the ability to remove certain 
functions (word predictability, etc) unless the FEATURE SWITCH APP is installed.   

https://chrome.google.com/webstore/detail/hide-research/fnifdkggkcjiaahokngjoajgpboaaojb
https://support.texthelp.com/help/feature-switching
https://docs.google.com/document/d/11iKnYjMGmqnErLrm-CJkV_UA_sKz8GtLy0jpWyluKW0/edit?usp=sharing
https://docs.google.com/document/d/11iKnYjMGmqnErLrm-CJkV_UA_sKz8GtLy0jpWyluKW0/edit?usp=sharing
http://support.texthelp.com/index.php?action=artikel&cat=5&id=224&artlang=en


 
Implementation nightmares of R&W - As Robert Barrett (right) has alluded to, R&W must be 
authenticated the first time is is pushed to the account.  This means you must remove the 
exam accounts from the secured OU, open each account and manually approve the “install”.  
Once they are approved you would move them back into the secured exam OU.  
 
To solve this issue we created a number of accommodation exam accounts that are not 
deleted daily (only the passwords are reset) and the supervisors of those accommodations 
are required to check the drives (before and after the exam) and ensure that all exam 
materials have been properly deleted.  This means you only need to authenticate RW once. 
 
 ALSO: The Screenshot Reader function does not work with the above exam 
settings.  
 
Autocorrect Features 
We have received lots of questions regarding the Autocorrect feature.  The Spell Check feature 
in Google Docs is allowed by Alberta Education (Aug 2015) - (Rules and Procedures, pg.5, #2). 
https://education.alberta.ca/media/1477310/06-ach-gib-2015-16-using-calculators-computers.pdf   
The underline spelling feature is allowed so long as it does not automatically correct the spelling 
(which it does not by default in Google Docs).﻿  The autocorrect feature only autocorrects words 
that have been placed into the dictionary by the user.  Since these are exam accounts, this is 
not a concern and is compliant to the directives of AB ED.  Example below: 
 
This is an excabml of the autofroc feature in Google docuemnts. 

https://education.alberta.ca/media/1477310/06-ach-gib-2015-16-using-calculators-computers.pdf


MP3’s for Accommodated Writers 
Principals download the MP3’s provided by Alberta Education.  They upload them into a 
secure Google account and share the MP3’s with a select number of exam accounts that 
have been identified for accommodated students.  Here is a quick YouTube video on how 
RDPSD is managing them: https://goo.gl/38ZM1J 

French Writers considerations 
If your students need to write their exam in French, it is recommended that you select a 
number of Chromebooks from your fleet and make French the default keyboard on those 
devices.  Then, on 
the day of the 
assessment those 
devices should be 
used by the 
students writing 
in French.  
Currently there is 
no way to push 
out a keyboard 
language from the 
Admin Console 
and for a number 
of security 
considerations we 
are not 
recommending allowing students access to the Chromebook Settings.   
 
UPDATE:  SEE RIGHT 
 
Google has pushed out a new admin feature that allows admins to push out keyboards by 
OU.  Can be found under Device Management - Device Settings. 
 
 
 
We are also experimenting with French USB keyboards.  Will let you know how they work... 

Other Solutions and Documentation from other Jurisdictions 
Wolf Creek - https://goo.gl/GshS1F 
Parkland - https://goo.gl/s7wUZ2 

https://goo.gl/38ZM1J
https://goo.gl/GshS1F
https://goo.gl/s7wUZ2


Edmonton Public -  

Other Suggestions  
1.​ The proctor could be assigned resetting passwords to a specific OU. When a student 

is completed the proctor resets their password. They only have rights to the 
accounts they are monitoring for the exam.  This could be done when a student has 
completed the exam. This ensures not signing in after they hand in the exam and 
leave. It’s not important for the proctor to remember the password they changed it 
to as admin or themselves would be able to go reset it if there was a need.   This one 
is likely best only to be used in a testing domain as you likely don’t want 
them to have free access since it is domain base reporting. Another thing 
that is possible is (Not OU base.) But the proctor could have access to Reports. 
Reports is domain base so is likely best in a testing domain. They could then 
monitor drive activity with the different filters that can be used in drive such as 
“user Sharing Permissions changed.” 
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